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National NHS Staff Survey 2004 Guidance Notes 
 
 
Introduction 
 
The main purpose of these Guidance Notes is to guide trusts, PCTs and Survey 
Contractors through the practical steps of conducting the National Staff Survey.  The 
guidance notes are separated into two main sections. 
 
Part One - Introduction to the National Survey 

 
1.1. Background to the survey 
1.2. Summary of minimum survey requirements 
1.3. Timetable for the survey 
1.4. Changes since the 2003 survey 
1.5. Health and Safety Executive Stress Audit 
1.6. Immediate preparation for the 2004 survey 

 
Part Two: Step by step instructions for the National Staff Survey  
 

2.1. Key survey contact within the trust 
2.2. Approved Contractors 
2.3. The questionnaire 
2.4. Breakdown of results by directorate / department / site 
2.5. Preparation of staff lists 
2.6. Selecting the Staff Sample 
2.7. Pre-survey communication with staff 
2.8. Other ways of boosting response rates 
2.9. Printing of questionnaires, covering letters and reminder cards/letters 
2.10. Distribution and receipt of questionnaires, and prompting non-respondents 
2.11. Data entry and data transfer to the Advice Centre 
2.12. Reports of the survey findings 
2.13. Ethical considerations  

  
The appendices contain templates of the letter to accompany the questionnaire, the 
reminder letters, as well as details of information and documents to be transferred to 
the Advice Centre. They also include a list of changes to the Core questionnaire from 
2003, a sample honorary contract for when staff home addresses are used for 
questionnaire distribution, ethnic background codes to be included in the staff list, 
and some instructions for carrying out basic operations in Excel (necessary for the 
sampling stage). 
 
 
An Advice Centre web site and advice line is available for the National Staff Survey. 
 
• Web site: www.nhsstaffsurveys.com 
 
• Advice Line: 0121 359 2491 (9.30am – 4.30pm, Monday to Friday). 
 
• E-mail: Glenys Foskett (G.M.Foskett@aston.ac.uk) or Sue Holtom 

(holtoms@aston.ac.uk) 
 
Researchers from the Advice Centre will provide practical support and advice to the 
trusts as they conduct the survey. 
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PART ONE: INTRODUCTION TO THE NATIONAL SURVEY 
 
 
1.1. Background to the survey 
In 2003, the Commission for Health Improvement (CHI), in conjunction with the 
Department of Health, appointed Aston University to develop and pilot a new national 
NHS staff survey, and to establish an Advice Centre and web site to support that 
process. The three organisations worked in partnership to consult widely with NHS 
staff about the content of the survey, under the guidance of a stakeholder group, 
which had representatives from Staff Side, CHI, DH, HR Directors, Strategic Health 
Authorities and the NHS workforce. 
 
The purpose of this survey was to collect staff views about working in their local NHS 
trust.  The intention was that it would replace the need for trusts to carry out 
numerous staff surveys – it was designed to replace trusts' own annual staff surveys, 
the Department of Health 10 core questions, and the CHI Clinical Governance 
Review staff surveys.  It was intended that this survey would be implemented 
annually, and cover the needs of CHI, DH and trusts.  Thus, it would provide 
information both for deriving national performance measures (including star ratings) 
and for helping the NHS, at both a national and local level, work towards Improving 
Working Lives.   
 
After a pilot study in five trusts, the survey was implemented in full in the autumn of 
2003. Every NHS trust in England took part, with nearly 370,000 staff sent 
questionnaires. 56% of these responded, and the data was analysed by the Advice 
Centre at Aston University. In addition to there being two national reports (one a brief 
summary of key findings, the other containing longer, in-depth analysis), each trust 
received an individual feedback report, which (for the first time) allowed them to 
compare their own scores against benchmarks from other similar NHS organisations 
on a range of measures of staff satisfaction and opinion. These reports, together with 
spreadsheets of detailed responses to the survey from each trust, are available 
online at http://www.chi.gov.uk/eng/surveys/nss2003/. 
 
CHI has now been replaced by the Healthcare Commission, which has taken over 
responsibility for the survey. It will continue to be operated as an annual survey. 
 
 
1.2. Summary of minimum survey requirements 
It will again be obligatory for all NHS trusts in England to implement the survey with a 
sample of their staff in the Autumn of 2004.  (Strategic Health Authorities, Workforce 
Development Confederations and other NHS employers are also encouraged to 
conduct the survey, although it is not compulsory that they do so). 
 
All trusts must follow a standard methodology, as described in detail later in these 
guidance notes, and must fulfil the following minimum requirements. Note that, unlike 
last year, it is now compulsory for trusts to use an external survey contractor for 
parts of the survey process:- 
 
• A self-completion questionnaire with a random sample of staff 

(see section 2.6 for more details on sampling) 
 
• The questionnaire must contain the full set of Core questions 

(see section 2.3 for more details on the questionnaire) 
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• A staff survey communication strategy must be implemented 
(see section 2.7 for more details on internal communication) 

 
• Questionnaires (each labelled with a unique staff ID number) to be distributed to 

selected staff, with at least two reminders being sent to non-responding staff (2nd 
reminder to be accompanied by a 2nd copy of the questionnaire) 
(see section 2.10 for questionnaire distribution procedures) 

 
• An external organisation must be appointed to act as a survey contractor. As a 

minimum, this organisation should be responsible for receipt of completed 
questionnaires, data entry and editing, and provision of this data to the Advice 
Centre. It is strongly recommended that trusts use one of the Approved Survey 
Contractors 
(see section 2.2 for details of the Approved Contractors) 

 
There are a number of additional ways in which trusts can adapt the survey to their 
local needs: 
 
• trusts may conduct a survey with a larger staff sample or census 
• trusts may select additional questions from an Optional Question Bank 
• trusts may include a limited number of their own Local questions on other topical 

issues 
 
More detail about all these survey elements can be found later in sections 2.3, 2.4, 
2.5 and 2.6.  
 
 
1.3. Timetable for the survey 
There will be more flexibility for trusts in the precise timing of the National Staff 
Survey this year; and the overall survey timetable from launch of the survey materials 
to data transfer deadline has been considerably extended.  This will give trusts more 
time for pre-survey preparation, and will give staff longer in which to complete and 
return questionnaires.  
 
Questionnaires should be distributed no later than the week commencing 4th October 
2003, but may be sent out up to a month before this if that is more convenient for 
trusts (e.g. to attach the questionnaires to payslips).  
 
Three weeks after the initial mailing (w/c 25th October if the initial mailing was w/c 4th 
October), trusts should distribute a first reminder letter to all staff who have not yet 
returned a questionnaire. . 
 
A second reminder letter, together with an extra copy of the questionnaire, should be 
distributed to non-responding staff a further three weeks later (w/c 15th November, if 
the initial mailing was in w/c 4th October).  
 
(Compared with the 2003 survey, the gaps between mailings of questionnaires and 
reminders have been extended, to allow for any problems with internal distribution.)  
 
Survey data should be transferred to the Advice Centre during the week commencing 
13th December 2003. 
 
National results and trust level results will be available in February/March 2005. 
Trusts are, however, able to commission reports based on their own data from their 
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contractors, which can be developed prior to the standard reports they receive from 
the Advice Centre. 
 
A detailed timetable for the survey can be found at the beginning of PART 2 (page 
8). 
 
 
1.4. Changes since the 2003 survey 
There have been a few changes to the survey procedures since the 2003 survey, to 
help improve the process. The main changes that affect trusts are listed below: 
 
• Due to many concerns about confidentiality of responses in the 2003 survey, it is 

now mandatory for trusts to use a contractor (an external organisation) for certain 
parts of the survey process: these are receipt of completed questionnaires, data 
entry and transfer of data to the Advice Centre. It is strongly recommended that 
trusts use one of the seven Approved Contractors (see section 2.2). 

 
• Ethical approval has now been gained for questionnaires to be sent to home 

addresses for staff who do not have a permanent work address, and thus for 
whom other documentation (e.g. payslips) is already sent to their home address. 
Please note that staff who do have a regular work address should receive 
questionnaires via trust internal post, as last year. To maintain confidentiality of 
staff information, special procedures need to be in place if home addresses are to 
be used – see section 2.4 for further information. 

 
• The Advice Centre feedback reports will this year be able to incorporate 

breakdowns of trusts’ results by directorate, division, department or location (or 
some other such breakdown). To enable this, details of which category a staff 
member belongs to will need to be included in the staff list used for sampling and 
ID numbers. (see section 2.3). 

 
• So that the Advice Centre can monitor response rates by different ethnic groups, 

trusts should include ethnic background information in the staff list provided to 
contractors. This is important since it will be an opportunity to see if there is any 
bias in response between different groups of staff (see section 2.3). 

 
• There are to be longer periods between questionnaires being sent out and 

reminder letters being sent to non-respondents: whereas in 2003, a two-week gap 
was used, a three-week gap will be used this year. 

 
• The first reminder letter will this year be in a sealed envelope, rather than on a 

postcard (see section 2.8). This is after concerns were raised during last year’s 
survey that reminder postcards placed in pigeon holes could be read by other 
members of staff, alerting them to the fact that individuals had not returned the 
questionnaire. 

 
 
1.5 Health and Safety Executive Stress Audit 
 
The questionnaire has included additional questions so that the Health and Safety 
Executive’s (HSE) stress audit is covered by the questionnaire. Details of the 
questions which map onto the HSE standards can be found in Appendix 2.10. The 
HSE has agreed that trusts will not need to carry out a separate survey to cover this. 
The HSE and Healthcare Commission are currently discussing how trusts can use 
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this data to report on the survey in such a way that meets HSE requirements. This 
information will be passed to trusts as soon as it is agreed. 
 
 
1.6. Immediate preparation for the October survey 
There are a number of key tasks that should be started as soon as possible, to help 
ensure that organisations are ready to conduct the survey: 
 
• updating of the trust staff database, including accuracy of work address 

information (or home address information if applicable – see section 2.4), in 
preparation for selecting the staff sample (see sections 2.4, 2.5) 

• making contact with the Advice Centre, to let them know which members of staff 
will be responsible for the survey implementation (please see section 2.1) 

• making contact with an Approved Survey Contractor, who will be able to help the 
trust with the preparation for and implementation of the survey (see section 2.2) 

 
 
Please see page 3 for contact details of the Advice Centre. 
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PART TWO: STEP BY STEP INSTRUCTIONS 
 
The following step-by-step instructions are designed to guide trusts, PCTs and 
Survey Contractors through the survey procedures. 
 
An Advice Centre, based at Aston University, has been set up to support the whole 
process.  You will have access to the Advice Centre throughout the National Staff 
Survey period.  See page 3 of these Notes for information on how to contact the 
Advice Centre. 
 
The timetable of steps necessary for survey implementation is given in the following 
table: 
 
Date Step of Survey Implementation By whom? Section in 

Guidance 
Notes 

By mid-August 
04 

Identify two individuals within the trust who 
will take responsibility for the survey and 
inform the Advice Centre of the contact 
details of these people 

Trust 2.1 

By September 
1st 

Ensure staff lists are comprehensive and up 
to date 

Trust 2.5 

By end August 
/ early 
September 04 

Appoint a survey contractor to help with the 
survey implementation 

Trust 2.2 

By w/c 
September 
13th 

Agree the precise division of labour between 
trust and contractor (e.g. who is responsible 
for sampling, printing, packing  survey 
materials ready for distribution, taking receipt 
of completed questionnaires, monitoring 
response rates etc) 

Trust and 
contractor 

2.2 

By w/c 
September 
13th 

Decide on the precise content of the 
questionnaire, and communicate this to 
contractor (all trusts must include the Core 
questions) 

Trust 2.3 

By w/c 
September 
13th 

Decide on what within-trust breakdown (e.g. 
directorate, department or location) should be 
used, and ensure that this information, and 
ethnic background information, is included in 
the staff list 

Trust 2.4 

By w/c 
September 
20th 

Communicate with trust staff.  Arrange some 
internal publicity within the trust about the 
forthcoming survey. Include intention to 
distribute questionnaires to home addresses 
if applicable. 

Trust 2.7 

By w/c 
September 
27th 

Arrange printing of the various survey 
documents - questionnaires, letters, reply-
paid envelopes (each questionnaire to be 
printed or labelled with a unique staff 

Trust or 
contractor 

2.9 
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identification number to help with monitoring 
response rates and targeting reminders) 

By w/c 
September 
27th 

Inform the post room(s) of the forthcoming 
questionnaire distribution and reminders, 
ensuring that they are aware of the 
importance of the survey and the likely 
volume of post 

Trust 2.7 

By w/c 
September 
27th 

Set up honorary contracts with contractor if 
home addresses are to be used for 
questionnaire distribution 

Trust and 
contractor 

2.5 

w/c October 
4th1 

Arrange distribution of questionnaires to the 
selected sample via the internal post or home 
addresses 

Trust or 
contractor 

2.10 

Weekly Monitor response rates to this first mailing, 
and make use of the unique ID numbers on 
returned questionnaires to record which 
members of staff have not yet responded  

Contractor 2.10 

w/c October 
25th2 

Three weeks after the initial mailing, arrange 
distribution of a reminder letter to all staff who 
have not yet returned a questionnaire 

Contractor 
and trust 

2.9 

Each week 
during survey 
period 

Monitor response rates to this second 
mailing, again identifying remaining non-
responding staff  

Contractor 2.10 

w/c November 
15th3 

Three weeks after the first reminder letter, 
arrange distribution of a 2nd copy of the 
questionnaire to all non-responding staff, 
together with a reminder letter and another 
reply-paid envelope 

Contractor 
and trust 

2.10 

w/c December 
13th 

Arrange for data from the completed 
questionnaires to be keyed or scanned, and 
to be transferred to the Advice Centre in the 
prescribed format 

Contractor 2.11 

 
 
2.1. Key survey contacts within trust 
 
At the start of the process, it is important to identify two people within the trust who 
will take responsibility for the survey and communication with the Advice Centre and 
survey contractor. Although it is likely that only one of these will actually have 
responsibility for the survey, the 2003 survey showed that contact between the 
Advice Centre and trusts was far smoother where there were two named contact 
people, as there were fewer delays due to sickness or absence etc. 
 
If your trust has not already informed the Advice Centre of the names and contact 
details of these individuals, it should do so at the earliest opportunity. 
 

                                                 
1,2,3 Or earlier date: see section 2.9 
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2.2. Approved Survey Contractors 
 
We are strongly recommending that trusts appoint one of the seven Approved Survey 
Contractors to support them.  These contractors have been fully vetted by the 
Healthcare Commission, and have proved that they are able to provide a high quality 
service whilst offering value for money.  They all took part in the 2003 survey with 
great success. 
 
As a result, it is not necessary for trusts to conduct their own lengthy and costly 
individual tender exercises.  
 
All seven Approved Contractors have been briefed in detail by the Advice Centre, 
and will be in close liaison with Advice Centre staff throughout the survey period.  
Furthermore, all Approved Contractors have contracts with the Healthcare 
Commission, under which they guarantee the provision of a high quality service. 
 
The seven Approved Contractors are:- 
 
• Maritz 
• MORI 
• NHS Partners’ Research & Information 
• Picker Institute Europe 
• Quality Health 
• RBA Research 
• Taylor Nelson Sofres 
 
Contact details for these seven organisations can be found in Appendix 7.  More 
detailed information about them, including their quotations for providing the survey 
services can be found in the Service Level Agreement which is available on the 
Advice Centre web site.. Although there are some differences between the 
contractors, in general they all offer similar services at similar prices. 
 
When using an Approved Contractor, trusts can select from a menu of services, 
including: 
  
• Providing advice and support to trusts in selecting the staff sample 
• Printing questionnaires, covering letters and reminders 
• Packing up survey materials, ready for internal distribution by the trust  
• Handling receipt of completed questionnaires, and liaising with trusts about non–

responses and the distribution of reminders* 
• Providing support to ensure good response rates 
• Data entry and transferring the cleaned data to the Advice Centre* 
• Analysis and reporting of findings (n.b. the Advice Centre will be providing each 

trust with a basic set of tables with the core question findings in Feb / Mar 2004) 
 
(* it is mandatory that these elements are handled by an external contractor for 
confidentiality reasons) 
 
The precise work to be carried out by the approved contractors will vary from trust to 
trust.  While some trusts may choose to appoint a contractor to conduct the whole 
survey, others may wish to do some of the work themselves in order to keep costs 
down.   
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When deciding on what parts of the process to use the contractor for, it is worth 
remembering that the use of an approved contractor can help to limit the burden on 
trust staff time.  The amount of staff time needed to co-ordinate a large-scale survey 
is often under-estimated.  In particular, organising the printing and packing of survey 
materials, can be very time-consuming tasks, and can take trust staff away from their 
usual work. 
 
Although we strongly recommend using an Approved Contractor, it is recognised that 
some trusts may choose to use a non-approved contractor.  If this is the case, it is 
essential that the instructions contained in the following pages are followed diligently 
by the contractor.  This is necessary to ensure all trusts are producing results that are 
comparable. It is also important that any non-approved contractors make contact with 
the Advice Centre, so that they can be contacted directly in case of any queries, and 
that data may be passed between the contractor and Advice Centre without 
compromising respondent confidentiality. 
 
 
2.3. The Questionnaire 
 
The next important step is to decide on the precise content of the questionnaire to be 
used in your staff survey.  The questionnaire has three potential components, only 
one of which is compulsory: 
 
• A set of Core (compulsory) questions, which must be asked in all trusts 
• A set of Bank (optional) questions  
• Local questions 
 
All trusts must include the full set of Core questions in their questionnaire, but also 
have the option of selecting additional questions from an Optional Question Bank.  
These can be put together using a Compilation Tool available on the Advice Centre 
web site (see section 2.3.4). It is hoped that the Core and Bank questions will cover 
all the key staff issues for the majority of trusts.  However, trusts also have the option 
of including additional Local questions, to cover issues of particular local interest. 
 
2.3.1. Core Questions 
The Core questions cover: 
 
• Work-life balance 
• Appraisals & Personal Development Plans 
• Training, Learning and Development 
• Team Working 
• Health and Safety 
• Errors and Incidents 
• Questions about respondents’ jobs (including involvement in decision making, 

work pressure, job satisfaction and intention to leave) 
• Management and Supervision 
• Organisational Climate 
• Equal opportunities 
• Whistle-blowing 
• Harassment and Bullying 
• Background Details. 
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Note that one question that formed part of the Core questionnaire last year (type of 
shifts worked – question 7b last year) is no longer a Core question. It is recognised 
that some trusts may wish to include this for comparability purposes, so this question 
now forms part of the optional Bank, although it now offers the opportunity for trusts 
to choose their own form of words and response options for the question. There have 
also been some alterations to a few of the other Core questions.  These are listed in 
Appendix 11. 
 
 
2.3.2. Inclusion of Bank questions 
The optional Bank questions cover: 
 
• Type of shift working 
• Length of time to travel to work 
• Further issues on Training, Learning and Development (difficulties in obtaining 

training, protected time, benefits received from training, climate for training) 
• Cleanliness, comfort and safety of the work environment 
• Pay and conditions 
• Discrimination at work 
• Directorate, division, department or location in which the employee works** 
 
These questions have been designed by the Advice Centre and, like the Core 
questions, have all been piloted successfully in NHS trusts.   Documents containing 
the Core questions only, and the Bank questions only, are separately available on 
the Advice Centre website. 
 
** Although a question has been included in the Optional Bank to collect information 
about the directorate, division, department or location of each staff member, a much 
better way of ensuring accurate analysis of results by directorate, department etc is 
for the trust to include it in the original staff list used at the sampling stage. (please 
see section 2.4 for detailed instructions about how to do this).. This is a much more 
reliable way of ensuring the information is available and correct for each staff 
member (e.g. in past trust surveys, staff have not always been sure in which 
directorate they work).  The Advice Centre will use directorate / department 
information on the staff list to present a directorate level breakdown of trust results in 
the standard feedback report in February 2005.  We would therefore strongly 
recommend that this method is chosen, rather than using the Optional Bank 
question.  However, the bank question can be used as a fallback option, if it proves 
too difficult for the trust to include the information on the staff list.   
 
Please note that the precise wording of the Bank question about directorate / division 
/ department will need to be amended to suit the local trust structure.  The 
Compilation Tool enables you to insert the desired question and answer categories.  
There is space for up to 12 different categories. 
 
If this optional directorate / department question is used, it may still be possible for 
Advice Centre reports to include results by this breakdown. Please ensure that 
contractors include all relevant information (breakdown used and codes used) when 
communicating this information to the Advice Centre. 
 
 
2.3.3. Inclusion of Local questions 
If there are additional staff issues which are very important locally, then it is up to 
trusts, and their appointed survey contractors, to design any additional Local 
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questions.  As far as possible, these local questions should be of a similar style to 
that of the Core and Bank questions, to retain consistency within the questionnaire.  
These should be designed on separate pages, but then added to the pages of the 
PDF generated by the compilation tool, so that all questions can be printed within a 
single booklet. Decisions about the inclusion of specific local questions should be 
made, and communicated to survey contractors, by the week beginning 13th 
September. 
 
Please note however, that according to the terms of the Ethical Approval granted by 
MREC North West Board for the National Staff Survey, trusts are required to submit 
any additional Local questions for approval by their Trust Management Board.  (All 
Core and Optional Bank Questions are already fully ethically approved for use 
nationally, and do not need to be submitted for further approval in this way.  For 
further details about ethical approval, see section 2.13).  
 
 
2.3.4 Creating the questionnaire for your trust 
Once it has been decided which questionnaire elements are required for use in the 
trust, the questionnaire can be generated using the Questionnaire Compilation Tool 
on the Advice Centre website (www.nhsstaffsurveys.com). The Compilation Tool 
inserts Bank (optional) questions into the appropriate place on the questionnaire. A 
username and password (chosen by individual users) need to be entered, to enable 
identification of each questionnaire, allowing it to be saved and retrieved. 
 
Trusts will have already been sent a PDF file of the 12-side Core questionnaire, with 
an electronic copy of these guidance notes. This should be used for reference only, 
and not for printing and sending out. If your trust has not yet received these 
documents, please contact the Advice Centre as soon as possible.   The Compilation 
Tool on the Advice Centre web site (described below) should be used for creating the 
questionnaire to be sent out – this will allow the insertion of the name, and return 
address, of an external survey contractor (essential to guarantee confidential 
treatment of staff responses).  
 
The Compilation Tool can be used to: 
• specify the address to which completed questionnaires must be sent (i.e. the 

postal address of the survey contractor) 
• specify a telephone helpline number that the contractor may have set up to 

answer staff queries 
• select optional Bank questions for inclusion in the questionnaire 
 
 
Once all the required elements have been selected, the questionnaire can be 
generated by the click of a button, “Generate PDF”. This produces the questionnaire 
in a PDF format, which can then be saved on the website, saved to disk, or printed. It 
is important to check the questionnaire contains the desired Bank questions, and that 
the instructions on the front cover (in particular return address and helpline number) 
have been generated correctly. 
 
 
2.3.5 Length of the questionnaire 
As mentioned earlier, the Core questionnaire is 12 A4 sides in length.  Clearly, the 
inclusion of additional non-Core questions will increase the length of the 
questionnaire.  
 



 14

It is recommended that, if further Optional Bank or Local questions are added, the 
questionnaire should be limited to a maximum of 16 A4 sides.  A questionnaire that is 
longer than this will have an adverse effect on response rates. 
 
 
2.4 Breakdown of results by directorate / department / site 
 
Two issues became clear during the 2003 NHS staff survey:-  
 

• firstly, that the survey findings would be more useful to trusts, if they had the 
opportunity to analyse their survey results by directorate or department 

 
• secondly, internal distribution of questionnaires would be significantly easier 

for multiple-site trusts, if questionnaires could be sorted into separate batches 
for each site. 

 
Both these issues can be addressed at the staff list preparation stage, if trusts 
provide department and/or site information for each member of staff on their staff list. 
 
Section 2.5 goes through each step involved in preparing a staff list for the survey.   
 
Before this staff list preparation begins, trusts need to decide on a suitable 
departmental or directorate breakdown (for use in analysis of the survey findings).   
 
1. This breakdown should have mutually exclusive and comprehensive categories, 

i.e. each member of staff should be included in one, and only one, of these 
categories 

 
2. These categories may be directorates, or departments, or locations, or any 

similar type of breakdown that is appropriate for the trust 
 
3. If a directorate breakdown is required in the Advice Centre report, then careful 

thought needs to be given to the design of the categories, to ensure that a large 
enough number of staff are contained in each category.   
 
The Advice Centre report will focus on the Basic Sample of 850 or fewer staff 
(see section 2.6.1); and in order to maintain confidentiality for individual staff 
members, the Centre report will not provide feedback on any group from which 
there are 20 or fewer responses.  Therefore, the directorate or department 
categories should be designed in such a way that there will be a minimum of 40 
staff in the Basic Sample. For trusts with a Basic Sample of 850, this is 
approximately 5% of the sample, so categories should represent a minimum of 
5% of the staff list. For trusts with smaller Basic Samples, this should be adjusted 
accordingly. 
 
We recommend that trusts talk directly to their survey contractors (or the Advice 
Centre) at an early stage about the precise design of their directorate / 
department breakdown.  This will help to ensure that trusts' later analysis and 
reporting requirements can be met. 
 
(Please note: there is a limit to the breakdown possible in the Advice Centre 
report, but if the trust is conducting the survey with a larger staff sample, then 
more detailed directorate analysis may be possible.  Again, trusts should talk 
directly to their survey contractors about this when they are preparing their staff 
lists for the survey). 
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4. Once suitable directorate / department categories have been agreed, each 

member of trust staff will need to be assigned to an appropriate category. 
 
5. As mentioned earlier, some trusts may want their survey contractor to organise 

separate batches of questionnaires for different sites within the trust, to help with 
internal distribution.  If so, then the site needs to be clearly identified on the staff 
list for each staff member.  (In some cases, site may be the same as directorate / 
department).  Again, it is recommended that trusts talk directly to their survey 
contractors about how best to identify site on the staff lists. 

 
Now please see section 2.5 for more information about preparation of the staff lists 
for sampling.  
 
 
2.5. Preparation for Sampling 
 
2.5.1 Preparation of Staff Lists 
One of the first steps towards conducting the staff survey is to compile a list of all 
staff that are eligible for the survey.  This needs to be carried out by a member of 
trust staff, who is familiar with both the structure of staff records, and the computer 
programme Microsoft Excel. Please note that preparation of this staff list is the 
responsibility of the trust, not of the contractor. 
 
This list should include: 
 

• all full time and part-time staff who are directly employed by the trust on 
September 1st 

• trust employees on all types of contract  
– permanent 
– fixed period 
– locum 
– temporary 
– seconded staff (e.g. social care staff seconded from the local authority), 

but only if they are on the trust payroll 
– hosted staff who have a substantive contract with the trust 

 
The list should exclude1: 
 

• staff who are on long-term sick leave or maternity leave on September 1st   
• all staff employed by sub-contracted organisations or outside contractors 
• bank staff (unless they also have substantive trust contracts) 
• seconded staff who are on the payroll of another organisation (e.g. social care 

staff who are on the payroll of the local authority) 
• student nurses 
• non-executive directors 

 
1If trusts want to use the questionnaire to survey some of these excluded groups, they may do 
so as long as they do not form part of the Basic Sample. To do this, it is recommended that 
trusts follow these Guidance Notes to draw the Basic Sample, and then add on other staff 
groups afterwards. That way, responses from staff groups that are supposed to be excluded 
from the National Staff Survey will not be fed back to the Advice Centre (this would 
compromise the comparability of survey results between trusts). Please note, however, that 
authorisation should be obtained to survey any employees of external organisations. 
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Care should be taken to ensure that: 
• no eligible staff members have been omitted from the list; (this could 

potentially happen if, for example, staff records are kept separately for 
different departments or sites within the trust) 

• the list does not contain duplicate names 
• all ineligible staff have been excluded from the list 
• records are up to date as of September 1st, including address information 

 
If HR provision is shared between multiple trusts, then it is important that staff lists 
are separated in such a way that a separate sample can be drawn for each trust, not 
one overall sample for the provision. The staff list for each trust should be consistent 
with the instructions above. 
 
It is acknowledged that for some trusts, particularly PCTs, this process may cause 
particular problems. If there is any doubt about what needs to be done in a particular 
case, please contact the Advice Centre. 
 
The staff list should be in Excel spreadsheet format, with one employee per row.  The 
first row should be used for column headings (Name, Staff Group, Address etc.), and 
there should be no blank rows.  Each employee should appear only once on the 
spreadsheet.  For each employee, the spreadsheet should contain the following 
information: 
 

• Full name 
• Sufficient address details (for internal distribution where staff have a 

permanent work address, or home address if not – see below) 
• Directorate, department or division (or whatever breakdown is required for the 

report – see section 2.4) 
• Location (if the questionnaires are to be separated into batches for different 

post rooms – see section 2.10) 
• Ethnic background 
• Job title * 
• Staff Group * 

 
If the address provided is a work address, it needs to be sufficiently detailed to 
enable a questionnaire to be sent to each individual via the internal mail. However 
please bear in mind that unlike last year, it is now permissible to send questionnaires 
to home addresses of staff who do not have a permanent work address. If this is to 
be done, home address information for these staff needs to be included in the list. 
For more information on sending to home addresses, please see section 2.5.2. 
 
Ethnic background information is being collected so response rates for different 
ethnic groups can be monitored. This will enable the Advice Centre and the 
Healthcare Commission to determine whether there is any bias in responses 
between different groups of staff. The ethnic group should be coded using the 
standard Department of Health ethnic group codes, which can be found in Appendix 
9. 
 
The asterisked information above is not absolutely essential, but would be extremely 
valuable both in monitoring response rates. It could also be used by the survey 
contractor for analysis purposes, although it will not be included in the standard 
Advice Centre report. Information on job title may be used to help improve the 
occupational group question in subsequent years. 
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For further details of how staff lists should be formatted within Excel, see steps (a) to 
(c) of the instructions in section 2.6.3. 
 
2.5.2 Use of home addresses – ethical considerations 
If questionnaires are being sent to home addresses of any staff members, there are 
three steps that will need to be taken by trusts to comply with the ethical approval 
decision granted. 
 
1. To ensure there is no invasion of privacy, trusts should communicate to their 

workforce that ethical approval has been granted to deliver questionnaires to the 
home addresses of some of their staff on the grounds that there is no permanent 
point of contact for these staff in the trust; and furthermore that a named person 
in the trust is available for any of their staff to contact should they object to this 
procedure. The named person will then ensure that that any objecting staff 
member’s home address is not included on the sampling data base, and internal 
distribution would then be used for such staff. A template for this communication 
is included on the Advice Centre web site. 

 
2. The letter that accompanies the questionnaire will contain a clause to explain that 

staff who are unable to be contacted easily at their work base have been sent 
the questionnaires at their home addresses. A version of this letter can be found 
in Appendix 1. 

 
3. Any trust which is using an external survey contractor for sampling and/or 

questionnaire distribution, and that wishes to distribute questionnaires to home 
addresses should set up an honorary contract between the trust and one or 
two people who are already employed by the external contractor.  Under the 
terms of this contract, one or two named employees of the contractor become 
unpaid employees of the trust (while continuing to be employees of the external 
contractor) during the period in which the survey is carried out. It is then 
permissible for the contracted employee to be given staff contact details for the 
sole purpose of sending out questionnaires and reminders to staff. The external 
contractor must be registered under the Data Protection Act and appropriate 
steps must be taken to protect employee confidentiality (in the case of the 
Approved Contractors, these procedures are already in place). A sample 
honorary contract, with recommended text, is shown in Appendix 8. Use of 
these contracts is already standard practice in the National Patient Surveys. 

 
Please note that questionnaires should not be sent to home addresses of staff who 
have a permanent work address. 
 
 
2.6. Selecting the Staff Sample 
 
It is important that random sampling is used to select the Basic Sample.  Random 
sampling provides a statistically valid way to gather data from a manageable portion 
of the population. It allows us to take results obtained in the sample and use them as 
our best estimate of what is true for the relevant population. 
 
Once the staff list has been compiled in Excel, it will need to be passed to the survey 
contractor (if appropriate), or the person in your trust responsible for sampling, who 
will then take responsibility for drawing the staff sample.  
 
All trusts and PCTs must select a random sample of employees, in accordance with 
the following detailed instructions.  This sample is referred to as the Basic Sample 
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throughout these instructions.  The size of this Basic Sample will depend on the size 
of the trust, as explained below.   
 
Some trusts may want to conduct the staff survey with a larger sample than is 
required, or conduct a Census within the trust.  This is perfectly acceptable.  
However, please note that in such cases, it is still necessary to randomly select (and 
later be able to identify) the Basic Sample, according to the instructions below.  It is 
only the data provided by this Basic Sample which will be fed back to the Advice 
Centre, and will be used by the Advice Centre, the Healthcare Commission and DH. 
 
2.6.1. Determining the size of the Basic Sample 
The size of the Basic Sample is determined by the number of employees in the trust 
eligible to receive a questionnaire (i.e. the number of people on the staff list identified 
in section 2.5.1). This varies in order to guarantee a similar degree of accuracy in 
the results for all trusts. The Basic Sample sizes are: 
 

Staff eligible to receive questionnaire Basic Sample size 
Up to 600 Census 
601-1000 600 

1001-1500 700 
1501-2000 750 
2001-3000 800 
Over 3000 850 

 
 
2.6.2 Relative merits of surveying the Basic Sample alone, a larger sample, or a 
census 
The advantages of conducting the survey among the Basic Sample alone are that it 
keeps costs to a minimum, and also limits the burden upon staff time.  The minimum 
sample sizes have been designed to ensure that the survey findings will give a 
statistically representative picture of the views of all staff in the trust. 
 
If trusts are considering surveying a larger staff sample or conducting a census, the 
advantages would include the possibility of more detailed sub-group analysis (e.g. 
more accurate results by directorate or occupational group), and would give more 
staff the opportunity to give their opinions.  However, the disadvantages are 
increased costs and increased burden on staff time. 
 
n.b. If a trust surveys more than the Basic Sample, it is very important that the 
Basic Sample is still selected in the way described below, and that the full specified 
survey procedures are implemented.  It should be remembered that only data from 
the Basic Sample will be transferred to the Advice Centre, and it is only this data 
which will be used by the Healthcare Commission to develop national measures. 
 
 
2.6.3. Selecting a random sample of staff 
The following steps give detailed instructions of how to draw a random sample using 
Excel. For further details about performing general tasks in Excel (such as deleting 
rows or columns) please see Appendix 5.  
 
a) Row 1 to be used for column headings 
The first row should be for column headings, such as “Name”, “Address”, “Site” etc.  
 
 
b) One employee per row  
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Each subsequent row (beginning with row 2) should contain the details of one 
employee. Any blank rows, or rows containing other information (e.g. sub-headings) 
should be deleted. (See figure 1 for example.) 

 
Figure 1: An example of a data file ready for sampling 

 
c) Remove any irrelevant data 
Delete any columns containing data irrelevant to the sampling, which will not be of 
any use later in the process (e.g. pay scale).   However, please keep any information 
about job title or staff group, as this will be very useful in analysing the survey 
findings, and will also enable organisations to detect any problems with the response 
rates of particular staff groups during the survey period. Also, information on 
directorate / department / division / location (as discussed in section 2.4) and ethnic 
group (as discussed in section 2.5) should be retained throughout.   
 
d) Insert a random number generator column 
Go to the first blank column. Give it the heading “Random” by inserting this in the first 
row. This column will be the random number generator, necessary to do the 
sampling. 
 
e) Generate first random number  
In the second cell of the “Random” column (i.e. the row containing the details of the 
first employee) enter the text “= rand( )” (without the quotation marks). Press Enter, 
and this should generate a random number between 0 and 1 (see figure 2). 
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Figure 2: Generating random numbers 

 
f) Repeat this random number generation for all cells in that column 
The simplest way to do this is to click on the first random number cell, then click on 
the small black square at the bottom-right corner of the cell. Then drag this down to 
the last row containing employee details. When the mouse is released, a random 
number between 0 and 1 is generated for each cell. 
 
g) Sort the data from lowest to highest random number  
Return to the top of the list. Highlight all columns by clicking and dragging across the 
column headers (either letters – A, B, C etc. – or numbers – 1, 2, 3 etc.). Then click 
on “Data” > “Sort”. Ensure “Header row” is selected. Then use the first drop down 
menu under “Sort by” to choose the row entitled “Random” (see figure 3). Click OK. 
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Figure 3: Sorting the data into a random order 

 
h) Select the staff to participate in the survey 
The data should now have sorted itself into a random order.  The next stage is to 
select your staff sample.  If there are to be x employees in the survey, select the first 
x + 1  rows (including the column heading row), by dragging over rows 1 to x + 1.  
Please note here:  
• if you are only planning to survey the Basic Sample, x will be the minimum 

sample size, as stipulated in section 2.6.1. 
• if you are planning to conduct a survey with a larger sample of staff, then the x 

referred to above should be this larger number  
• if a census is desired, you should select all rows  
Copy and paste this information (as appropriate) into a new worksheet. Delete the 
“Random” column from this new worksheet. 
 
i) Each selected employee to be allocated a unique identification number 
In the new worksheet containing only the selected employees, you now need to add 
ID numbers to the data.  Choose the first blank column in the new worksheet. Give it 
the title “ID Number”. In the first cell of this column (beneath the column heading 
cell), enter the value “1”. Make a note of the location of this cell: for instance, if it is 
column G, row, 2, the location is G2. If it is column 6, row 2, the location is R2C6.   
 
j) Allocate consecutive ID numbers to each selected employee 
In the cell below this, enter the text “= G2 + 1” (without the quotation marks), 
substituting for G2 if appropriate (see figure 4). This should generate the value “2” 
when you press enter. Click back on this cell, and click on the small black square at 
the bottom-right corner of the cell. When released, a sequence of ID numbers from 1 
to x should be generated. 
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Figure 4: Assigning ID numbers 

 
k) Fix the ID number values, by replicating them in the next column 
This stage is very important to ensure that each selected employee is permanently 
linked to a unique ID number.  
 
Highlight (select) all the ID numbers, along with the column heading. Click on “Edit” > 
“Copy”. Then click on the first cell to the right of this column (in the first row), and 
click “Edit” > “Paste Special”. Click on “Values” and “OK”. This will replicate the ID 
numbers.  Delete the original column of ID numbers; these are liable to change if the 
file is re-sorted. 
 
l) Specify the Basic Sample 
The Basic Sample should consist of employees beginning with ID number 1. For 
instance, if the Basic Sample size is 750, the Basic Sample should comprise ID 
numbers 1 to 750. As it will be necessary to feed back an anonymised version of the 
Basic Sample file to the Advice Centre, it is necessary (either at this stage or later) to 
separate these individuals into a new worksheet.  If the sampling procedure is carried 
out by the trust, then an anonymised version of this file (i.e. with names removed) 
should be passed on to the contractor so that responses can be logged and sent to 
the Advice Centre. 
 
m) Quality checks on sampling procedure 
Before questionnaires are distributed, it is necessary to double-check that the Basic 
Sample has been selected and identified correctly.  Please conduct the following 
checks on the sample: 

• each member of the Basic Sample has an allocated ID number 
• no ID numbers are duplicated 
• the Basic Sample does not include any bank staff, staff working for external 

contractors, non-payroll staff or non-executive directors 
• the sample appears to be in a random order (i.e. it is not structured so that all 

occupational groups are together, or it is in alphabetical order) 
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• the proportion of staff in different staff groups or departments (where this 
information is available) appears appropriate for the trust – for example, if 50% 
of a trust’s employees are nurses, then approximately 50% of the sample 
should be nurses as well 

 
n) Retention of staff list and Basic Sample 
It is highly important, at this stage, to make sure the file has been saved.  The Advice 
Centre will carry out some random checks on sampling procedures during October 
and November. Therefore, it is necessary to keep Excel files containing the original 
staff list, and the Basic Sample, in case they are requested by the Advice Centre, 
until the end of 2004. The list containing the Basic Sample, including directorate / 
department and ethnic group information, should be retained for logging of responses 
by the contractor (if the sampling has been conducted by the trust, this should be 
passed to the contractor at this stage). 
 
o) Transfer of sampling information to the Advice Centre 
The total number of staff eligible to receive the survey, and the size of the Basic 
Sample selected, should be e-mailed to the Advice Centre no later than October 15th.   
If the sampling was conducted by the trust, the name and contact details of the 
person responsible for the sampling in the trust should be included, in case the 
Advice Centre have any sampling queries later on. If the sampling was conducted by 
the survey contractor, contractors should inform the Advice Centre of this. 
 
 
2.7. Pre-survey communication with staff 
 
It is important that trusts communicate with staff during September to inform them of 
the launch of the second national staff survey. Research evidence shows that good 
communication can improve survey response rates, and help to counter the negative 
feelings experienced when staff feel over-surveyed.   
 
The communications exercise should explain to all staff in your organisation:- 

• the purpose of the survey 
• the ways in which survey findings can be used to improve staff's working lives 
• how and when staff will be receiving a questionnaire 
• how and when staff will get feedback on results 

 
It also provides an opportunity to alert staff to some of the issues in the survey. In 
particular, the survey includes questions on “Appraisals or individual performance 
reviews” and “Personal development plans”. It is possible that some trusts may use 
different terminology for these HR practices, and staff would not recognise the terms. 
If trusts suspect that this is the case, the pre-survey communication should alert staff 
to the equivalence between the terminology used in their trust and the terminology 
used in the survey. 
 
It will also be important to mention results from the trust in the 2003 survey, and any 
action the trust has taken on the basis of the results. Staff are more motivated to take 
part in surveys if they can see a tangible outcome from the findings, or if their views 
are acknowledged through trust communication. Examples of how trusts have used 
the 2003 results to inform policies include: introducing a “holiday club” to help 
improve work-life balance, introducing monitoring of appraisals to ensure all staff are 
appraised, improving staffing levels in areas that are “high-risk” in terms of violence 
from patients (such as A & E), introduction of a team-based working policy across the 
organisation, and adapting work-life balance policies so that they are all-inclusive. 
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The communication exercise also provides an opportunity to thank staff for taking 
part in the survey (and for taking part in last year’s survey if that has not already been 
done).  
 
Examples of ready-made materials that can be used to publicise the forthcoming staff 
survey within trusts and PCTs are available to download from the Advice Centre web 
site.  These include briefing notes for managers, text that can be used in internal 
bulletins and team briefings, flyers that could be distributed with pay slips, and 
posters advertising the survey.  These examples of materials may be amended to 
suit local trust needs. 
 
Please note that it is a requirement under the Data Protection Act 1998 that trusts 
inform staff that they are administering a survey.   
 
2.7.1. The Post Room 
Keeping the Post Room informed about the forthcoming survey is particularly 
important, as the staff there will play a crucial part in the internal distribution of 
questionnaires and reminders.  During the 2003 survey, there were delays in some 
trusts due to questionnaires getting stuck in post rooms.  This was often due to post 
room staff being unaware of what was being delivered, and sometimes resulted in 
reminder letters being received by staff at the same time as questionnaires. Please 
see section 2.10 for further information about the survey distribution procedures. 
 
 
2.8. Other ways of boosting response rates 
 
The survey procedures detailed in these Guidance Notes have been designed as far 
as possible to maximise response rates: ensuring staff work addresses are up to 
date for internal questionnaire distribution; targeted reminders; mailing out 2nd 
copies of the questionnaire to non-respondents; timely publicity of the forthcoming 
survey; good internal staff communication; use of approved contractors experienced 
in achieving high postal survey response rates. 
 
However, we would also recommend the following ways in which trusts and 
Contractors can ensure a high survey participation rate: 
 

• sending out a clear message that trust management supports the survey 
• identifying "survey champions" within the trust, who can help with monitoring 

early response rates, and looking at ways during the survey period of 
encouraging response among low-responding staff groups and departments 

• seeking to get local press coverage for the staff survey, to increase interest 
and awareness (the Healthcare Commission will be organising a press release 
about the National Survey in early October, so there should be some coverage 
in the national press) 

• allowing staff to complete the questionnaire during working time 
 
The overall target is to achieve a 60% response rate to the National Staff Survey, 
and it is hoped that most trusts will achieve this.  Last year a 56% response rate was 
achieved overall, which was considered excellent for a transitional year (several 
trusts had conducted their own staff surveys less than a year previously, which may 
have depressed response rates). 
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While there will be no penalties for trusts not achieving a 60% response rate, it is 
very important that efforts are made to achieve as high a response rate as possible.  
Without this, the survey results cannot be said to be representative of the trust as a 
whole, and it will be these results that will be used by both the Healthcare 
Commission and DH to feed into national measures and ratings in 2005. 
 
The results of your survey may be affected by a number of external events at either 
the national or local level.  For example, your trust may have recently undergone a 
merger or some other large organisational change.  It is important to record any such 
events so that your results can be interpreted in the light of such influences, and 
when year-on-year comparisons are made, external circumstances may be taken into 
account. 
 
 
2.9. Printing of questionnaires, covering letters and reminder letters  
 
2.9.1. Questionnaires 
The questionnaire compilation tool described in section 2.3 should be used to create 
a PDF document containing the Core and any Bank questions for a particular trust.  
Any Local questions should be designed on separate pages, and added to the end of 
the pages of the PDF document before printing to form a single document. 
 
The questionnaire has been designed in black, white and green, and should 
therefore be printed in colour, rather than black and white.  Experience has shown 
that the overall look of a questionnaire, including the use of colour, helps to raise 
survey response rates. 
 
The green colour used in the questionnaire is Pantone 5753C, or R:102 G:102 B:0. 
The light green used for the bands at the top of each question is a 50% of the same 
colour. 
 
Questionnaires should be printed as A4 booklets (i.e. a 12-side questionnaire would 
be 3 folded A3 sheets, stapled in the centre). 
 
All selected staff within a Trust should receive an identical questionnaire, in terms of 
content and format. The only difference between questionnaires distributed to 
different individuals should be in the ID number assigned during the sampling 
procedure (see section 2.6.3).  There is an “Office Use Only” box on the front page 
of the questionnaire for this number to be printed or labelled.   
 
2.9.2. Covering and reminder letters 
There are three different types of letter / card, designed for use in the survey: 
 

• a covering letter, which should accompany the questionnaires and a reply-paid 
envelope (which should be printed with the return address) in the first mailing 

• a first reminder letter / card, to be sent to non-respondents three weeks later 
• a second reminder letter, which should accompany a second copy of the 

questionnaire and another reply-paid envelope sent to non-respondents a 
further three weeks later 

 
The text for these three letters has been prepared by the Advice Centre, and is 
downloadable from the Advice Centre web site.  The text is also given in Appendices 
1 to 3.   
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The Advice Centre has obtained ethical approval for this text.  If you make any 
substantial alterations to the text, you will need to seek the approval of your local 
Trust Management Board.   However, the text allows the insertion of a return address 
and telephone number for which no additional approval is necessary.  It also allows 
the inclusion or exclusion of a sentence about use of home addresses for 
questionnaire distribution, where appropriate.  The text also includes a sentence 
giving a number for visually impaired staff to complete their questionnaire verbally 
over the telephone. All Approved Contractors have agreed to this; if non-approved 
contractors are able to provide this service then they should insert their own helpline 
number here, or otherwise insert the Advice Centre number. 
 
All letters should be printed on paper headed with the Healthcare Commission logo. 
Trust logos can also be added to any letters if desired. The Healthcare Commission 
logo and signature are being sent to trusts and Approved Contractors with the 
electronic copy of these guidance notes. 
 
When calculating the number of questionnaires to be printed, you will need to allow 
for sending out second copies of the questionnaire with the 2nd reminder letters. 
Printing costs can be unnecessarily high if a second print-run is required, so it is 
worth ensuring that the first print-run is sufficiently large to allow for contingencies.  
As a rule of thumb, it is advisable to multiply the number of staff in the sample by 1.7 
to obtain the number of questionnaires likely to be required.  So, if the number of 
questionnaires you intend to send out is 850, then you might want to print 850 x 1.7, 
or approximately 1,500 copies. 
 
It should also be noted that for each questionnaire that is printed, a first class reply-
paid envelope should be printed also. These envelopes should be printed with the 
address to which questionnaires are to be returned (i.e. that of the survey contractor). 
 
 
2.9.3. Recycled paper requirements 
It is a requirement that all paper used in the publication of the NHS staff surveys, 
including questionnaires and corresponding letters, must conform to government 
requirements for the use of 100% recycled paper with a minimum post-consumer 
waste content of 80%.  It is further recommended that the paper used is uncoated 
and of standard A4 size. 
 
 
2.10. Distribution and receipt of questionnaires, and prompting non-
respondents  
 
Survey documents should be distributed to employees with permanent work 
addresses using the internal post (or other internal distribution mechanisms).  Where 
staff members do not have permanent work addresses, documents may be 
distributed to home addresses, subject to the procedures described in section 2.4.2 
being in place.   
 
Survey contractors may be used to prepare the survey packs, each labelled with a 
unique ID number, ready for internal distribution by the trust.  It is recognised that 
many trusts are based on multiple locations, each with its own post room, and in 
these cases it is preferable that survey packs be arranged into separate batches for 
the separate locations. It is the responsibility of trusts to ensure that contractors have 
sufficient information (provided with the staff list) to enable them to do this (see 
section 2.5). 
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The three survey distribution stages are summarised below: 
 
• w/c October 4th12 - staff survey packs containing a questionnaire, covering letter 

and reply-paid envelope, to be distributed to all selected staff (each questionnaire 
marked with a unique identification number, in order to monitor response and 
target reminders) 

 
• w/c October 25th3 -  reminder letters, to be distributed to selected staff who have 

not yet returned a questionnaire 
 
• w/c November 15th4 - a second reminder letter, accompanied by a second copy of 

the questionnaire and pre-paid return envelope, to be distributed to selected staff 
who have still not yet returned a questionnaire 

 
Printing instructions for the various documents can be found in section 2.9. 
 
As mentioned earlier, the Post Room(s) will play a crucial part in the internal 
distribution of questionnaires and reminders.  It is important therefore to inform the 
Post Room(s) that their work load will increase over the survey period, and that they 
will be the heart of the questionnaire distribution centre.  Our previous experience of 
distributing surveys has shown that it is useful to have the name of a key contact 
person in (each of) the Post Room(s), and that it is important to thank the Post Room 
staff for the extra work involved.   
 
In particular, the Post Room(s) should be warned in advance of the three distribution 
stages outlined above. 
 
Please note: We would advise both trusts and survey contractors to monitor this 
distribution during the survey period.  In past surveys, mailing out of the various 
survey packages has been delayed because Post Room staff were unsure of the 
distribution timetable.   
 
 
2.10.1. Taking receipt of completed questionnaires 
Each questionnaire should be marked with a return address to which staff should 
send their completed questionnaires.  As mentioned earlier, this should be the 
address of an external survey contractor, and preferably an Approved Contractor. 
The contractor should log the return of each questionnaire according to its unique ID 
number.   
 
At the end of the sampling process (section 2.6), an Excel file containing the names 
and ID numbers of the sample should have been saved, and passed to the contractor 
if the sampling was done by the trust. When a completed questionnaire for a 
particular ID number is returned, this should be noted on the Excel file by typing “C” 
in the cell immediately to the right of the ID number.   
 
Please use the following codes to record the different types of staff response, against 
the appropriate ID numbers: 
 
 
                                                 
 
2 or up to three weeks earlier 
3 or three weeks after initial mailing 
4 or six weeks after initial mailing 
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Response 
code 

Type of response 
 

  
C 
 

Completed questionnaire returned 

B 
 

Blank questionnaire returned 

REF 
 

Staff member explicitly opted out / refused to take part 

INEL 
 

Staff member ineligible for survey (e.g. no longer working at the 
trust, or not directly employed by the trust) 
 

N Questionnaire not returned (reason not known) 
 

 
 
For staff members who contact the trust or contractor to explicitly opt out of the study, 
or turn out to be ineligible for the survey, no more reminder letters should be sent. 
 
If a questionnaire is received in such a state that the ID number has been removed or 
made illegible, this questionnaire should not be included in data transferred to the 
Advice Centre.  However, the occurrence should be noted, and the number of 
questionnaires returned without legible ID numbers should be reported to the Advice 
Centre with the response rates. 
 
 
2.10.2. Monitoring response rates, and sending out reminders 
This log of questionnaire returns against ID numbers will enable contractors to 
monitor response rates during the survey period.  
 
For example, it may become apparent, using this log, that a particular department 
has a very low response rate compared with others.   If this is the case, it will be 
worth exploring the reason for that low rate.  It might be that distribution in that 
department has not taken place as planned, or it may be necessary to further 
publicise and promote the survey within that department. Contractors should ensure 
that they have systems set up to enable such monitoring. 
 
The log of questionnaire returns against ID numbers should also be used to target 
reminders at non-responding staff. 
  
First reminder 
Three weeks after the questionnaires are distributed, a reminder letter needs to be 
sent to all staff who have not yet returned a questionnaire (i.e. those ID numbers for 
which no questionnaire has been logged).  Please note that unlike last year, the first 
reminder should be in a sealed envelope. 
 
Please do not send reminders to staff whose questionnaires have already been 
logged. 
 
Second reminder 
Three weeks after the first reminder letter (six weeks after the initial questionnaire 
mailing), a further survey pack should be distributed to staff who have still not 
responded.   
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This survey pack should contain a reminder letter, a 2nd copy of the questionnaire 
(marked with each staff member's unique ID number) and a 2nd reply-paid envelope.  
 
Please do not send survey packs to staff whose questionnaires have already been 
logged. 
 
 
2.10.3. Informing the Advice Centre of ongoing response rates 
Please keep the Advice Centre informed of progress with response rates during the 
survey period.  If the Centre is made aware of problems with response rates at an 
early stage, Centre staff may be able to offer advice and help in raising the response. 
 
It is the responsibility of survey contractors to inform the Advice Centre of response 
rates on a weekly basis (every Thursday), from the week commencing October 4th 
onwards. Please also inform the Advice Centre of the dates that questionnaires and 
reminder letters were sent out, so that the effect of the reminders can be monitored. 
 
 
 
2.11. Data entry and data transfer to the Advice Centre 
– instructions for the survey contractor 
 
The deadline for transfer of data to the Advice Centre is Friday 17th December.  
 
This section gives information for contractors about how sample data, and data from 
returned questionnaires, should be entered and transferred to the Advice Centre. It is 
the responsibility of the contractor to enter data from returned questionnaires into a 
given Microsoft Excel file, and then to return this data to the Advice Centre at Aston 
University by 17th December. 
 
If it is clear that there will be a delay in transferring the data to the Advice Centre, 
please alert the Advice Centre at the earliest opportunity.  However, in order to meet 
the analysis and reporting requirements for the Healthcare Commission and trusts, 
we are reliant upon the vast majority of trusts meeting the target deadlines. 
 
The data to be returned by this date includes 2 files: 
• The anonymised staff sample file (Excel), containing records of which staff have 

and have not returned questionnaires 
• The questionnaire data file (Excel), containing data from returned questionnaires 
 
In addition, the final response rate should be reported to the Advice Centre along 
with this data.  The response rate is defined as the proportion of questionnaires 
distributed which are returned completed.  However, the number and proportion of: 
• blank questionnaires returned 
• questionnaires returned without legible ID number 
• staff members who explicitly opted out / refused to take part 
• staff members who were reported as ineligible for survey should also be reported. 
 
 
 
2.11.1. Staff Sample File 
This is an Excel file compiled during the sampling and questionnaire receipt stages, 
as described in sections 2.5 and 2.10.  The file should only include members of the 
Basic Sample, and should also include: 
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• ID number 
• whether or not they returned a questionnaire (or were ineligible, or refused to take 

part) – recorded as described in section 2.10 
• directorate / department etc. of staff (whichever breakdown is being used for the 

standard Advice Centre feedback report) 
• ethnic group of respondent (coded as described in Appendix 9) 
• job title if available. This information will be used for refining occupational group 

categories in future surveys 
 
This file should be anonymised, i.e. staff names should be removed.  
 
 
2.11.2. Questionnaire Data File 
Data from returned questionnaires must be entered into a fixed, consistent electronic 
format. It is important that the data is entered exactly as indicated in these 
instructions; if there are discrepancies then it may lead to mistakes in the data 
analysis. 
 
The data returned to the Advice Centre should only include members of the Basic 
Sample.  It should also include only data from the Core questions, not Bank or Local 
questions. 
 
Method of data entry 
A template for data entry is downloadable at www.nhsstaffsurveys.com. This 
template is a Microsoft Excel worksheet, containing column headings for each 
question on the questionnaire. The data from each questionnaire should then be 
entered into a single row on these worksheets.  All data from each contractor should 
be entered on a single worksheet, except where there are over 10,000 responses, in 
which case data should be entered on as few worksheets as possible. 
 
Data may be entered directly into these template worksheets, or may be copied from 
another worksheet.  Although the template includes only Core questions, contractors 
may find it easier to enter the data into another worksheet in questionnaire order, and 
then transfer only the Core questions into the template.   
 
Data should mostly be entered as numbers rather than words.  The first column is for 
a Trust ID code, and should include the three-letter NHS code of the trust for which 
the respondent works. 
 
The ID number of the questionnaire should be entered in the second column.  The 
third column is for the directorate / department information (coded numerically – i.e. 
with one number for each category), and the fourth for ethnic background (coded as 
described in Appendix 9). The fifth column should be used for the respondents’ job 
titles, where these were available from the original staff list (or left blank otherwise). 
 
Codes to be entered for the different question options are printed in small type on the 
questionnaire, adjacent to the relevant tick-boxes.  The only exceptions to this are: 
 
• two questions where respondents have the option to write in an answer – a 

separate column is provided within the Excel file for this information to be entered  
• the general comments box at the end, which should be entered into the final 

column as text, and in normal sentence case. These should be entered verbatim, 
except that names of individuals should be removed, and obscenities deleted (or 
asterisked out) 
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There are some scenarios when questionnaires do not contain data in the expected 
format: 
• Any questions left unanswered should be left blank in the Excel file. 
• For questions requiring a single tick only, if respondents have ticked more than 

one response at those questions, the data should be treated as missing (i.e. left 
blank) 

 
 
Data checking 
It is important that the following data entry checks are carried out on the Basic 
Sample data in each trust: 
 
• has the data been entered accurately? (this can be done by double-entering the 

data from a proportion of questionnaires, or directly comparing the hard-copies of 
the questionnaires to the entered data; if data is scanned, the latter check is also 
possible) 

 
• has the data been entered in the right columns in the data entry worksheet? (it 

can be easy to enter the correct data, but in an incorrect column)  
 

• for each question, have valid values been entered? (e.g. for a question with 
answer category values 1-5, check that there are no entered values outside this 
range) 

 
• does the file for transfer to the Advice Centre contain all completed questionnaires 

from the Basic Sample? (checks should ensure that no data from a Basic Sample 
staff member have been excluded from the file; and also that all data from non-
Basic Sample staff members have been excluded) 
 

 
The Advice Centre will be conducting some random quality checks on data entry 
during January 2005.  This means that some randomly selected specific 
questionnaires (identified by ID number) may be requested from and contractors, and 
these will be checked against the data provided.  Therefore, it will be necessary to 
retain all hard copies of questionnaires until at least the end of February 2005. 
 
Data cleaning 
The following instructions are for Approved Contractors, and for other contractors 
scanning (rather than keying) their questionnaire data. 
 
There are a number of filtered questions in the core questionnaire, and the following 
rules should be applied, when scanning or cleaning the data. 
 
Sometimes, a member of staff may have given inconsistent responses to a set of 
filtered questions (e.g. the appraisal question, which is Q8 in the Core questionnaire).  
For example, they may have said "No" to an initial filter question, but rather than 
following the instruction to skip onto a later question, they have answered the follow-
up questions. 
 
Taking the appraisal question as an example, the following rules should be applied: 
 
• If 8a is left blank, but there are answers given at 8b, 8a should be imputed as yes 
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• If 8a is given as “no”, but there are answers given at 8b, both questions should be 
set to missing (i.e. left blank) 

 
These rules should be applied to all questions with filter instructions – shown in green 
italics on the questionnaire. 
 
For the write-in questions, if it is clear from the written response that a different 
category should have been ticked (e.g. if someone writes in “Chinese”, which is a 
category in its own right), then the response should be changed appropriately. 
 
2.11.3. When the data has been entered 
Please save the staff list Excel file as the three-letter NHS code of the organisation 
from which the data came appended by “sample”, so that it can easily be identified by 
the Advice Centre. For example, for a trust with NHS code AAA this would be “AAA 
sample.xls” and “AAA data.xls”.  Contractors that are returning data from multiple 
trusts in the same worksheet should save the file with the name of the contractor. If 
multiple sheets are used, these should be given separate numbers, e.g. 
“Organisation1.xls”, “Organisation2.xls” etc. 
  
All files should also be password protected, with the password being assigned by the 
trust or contractor and sent to the Advice Centre in a separate e-mail. 
 
 
2.11.4. Transferring the data 
Please send the data on a floppy disk, or CD, to: 
 
NHS National Staff Survey Advice Centre, 
AMIRS, 
Main Building 252, 
Aston Business School, 
Aston University, 
Aston Triangle, 
Birmingham B4 7ET 
 
Please also e-mail the data to the Advice Centre at m.r.carter@aston.ac.uk, together 
with the following information: 
• the overall response rate for the Basic Sample 
• total number of valid responses received (i.e. those from the Basic Sample with 

data entered) 
• the number of blank questionnaires returned 
• the number of ineligible staff contacted 
• the number of questionnaires returned with ID number removed (overall – 

obviously not possible for each trust) 
• the number of questionnaires checked and errors found, contained within the text 

of the e-mail 
• the key for the codes used in the directorate / department etc. type breakdown   
 
Contractors who are conducting surveys for many trusts may return the data in bulk, 
as long as: 
• the total size of any e-mail is no more than 5MB 
• both documents for any trust, and the response rate & data checking information 

for that trust, are contained within a single e-mail (although passwords should be 
given in a separate e-mail). 
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2.12. Reports of the survey findings 
 
The Advice Centre will provide a report on the survey results for each trust.  These 
will include frequencies of staff responses to all Core questions, summary scores for 
all scales, some breakdown of scores within trusts, and guidelines for interpretation 
of scores.  All scores will be benchmarked against data for all trusts nationally and for 
similar types of trust. The reports will be similar to last years’, except that they will 
also include breakdown by directorate / division / department where possible. 
Examples of 2003 trust reports can be found online at  
http://www.chi.gov.uk/eng/surveys/nss2003/index.shtml 
 
These benchmarked reports will be published on the Healthcare Commission web 
site during February / March 2005.  A short report on the national data will be 
published in March 2005; a fuller report including in-depth analysis will be published 
in the summer of 2005. 
 
Some trusts may want to commission additional analysis of their own data, or early 
analysis of the trust level data, before the Advice Centre reports are published.  This 
must be negotiated separately with their survey contractors or data analysts. 
 
Data for the Advice Centre reports will be weighted by subgroups to ensure trust 
results are comparable.  The weightings used will depend on the average proportions 
for each group nationally.  Therefore it is possible that results given in the reports 
would differ slightly from those given in reports from contractors, even if only the 
Basic Sample was analysed in those cases. 
 
Details of how staff can access this information should be provided upon receipt of 
the report.  Experience of previous studies has shown that staff morale diminishes if 
they have no feedback after taking the time to complete a questionnaire.  
 
 
2.13. Ethical considerations 
Aston University were awarded ethical approval for the development of the National 
Staff Survey by the MREC North West Board. 
 
Trusts are required through the 1998 Data Protection Act to inform their staff that 
they are being surveyed.  Trusts are at liberty to choose the most appropriate forms 
of communication for their trust to enact this request. 
 
Trusts are not required to submit any local questions through their local LREC board.  
However, they are required to submit local questions for approval through their Trust 
Management Board. The Core and Bank questions provided by the Advice Centre, 
however, require no further approval. 
 
The Advice Centre is aware of the ethical implications of handling and storing 
sensitive data.  Space has been allocated to ensure that data will be stored in locked 
accommodation.  The data will be analysed on secure IT equipment that has strict 
password entry.  The Advice Centre is ultimately responsible to Aston University for 
the handling of sensitive data.    
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Appendix 1 
 

Covering letter to be sent to employees w/c October 4th (or earlier) 
[Sections in blue are to be altered according to each trust’s/contractor’s needs] 
 
Dear Colleague, 

NHS National Staff Survey 
 

We are writing to ask for your help with the 2004 National NHS Staff Survey, which is 
being conducted by researchers from [contractor], Aston University and the 
Healthcare Commission.  [Your name was selected at random from a list of all staff 
working for your trust.] [Please note that some staff who do not frequently report to a 
permanent work address may have been sent a questionnaire at their home 
address.] 
 
The survey asks for your views about work and the health care organisation for which 
you work.  The aim of the survey is to help the NHS to provide better care for patients 
and improve the working lives of staff.  Your employer will be able to use the survey 
to inform improvements in working conditions and practices at a local level.  The 
Healthcare Commission will use the survey findings in their reviews of the NHS, and 
to develop performance indicators which will form the basis of NHS star ratings in 
2005.  The survey results will also enable the Department of Health to assess the 
effectiveness of national NHS staff policies (such as training and flexible working 
policies) and to inform future developments in this area.   
 
The 2003 survey, which was the first ever NHS National Staff Survey, was highly 
successful and highlighted several important strengths and weaknesses in the NHS. 
The 2003 results can be accessed online at www.healthcarecommission.org.uk.  A 
similar survey is being conducted in all trusts in England this year, which will enable 
us to observe any changes in staff views and experiences over the past year.  This is 
an important way of ensuring that NHS staff views regularly feed into local and 
national policies.  Therefore we would urge you to complete this questionnaire, even 
if you took part last year. 
 
Your participation in the survey is entirely voluntary.  However, by completing the 
questionnaire, you will provide valuable information which will be used to improve 
NHS working practices and patient care.  The results of this survey will only be truly 
representative if all selected staff complete and return the questionnaire. 
 
Your answers will be treated in the strictest confidence.  No one from your trust will 
see your completed questionnaire or be able to identify an individual's responses.  
The completed questionnaires will go straight to [contractor], an independent survey 
organisation, and the anonymous survey findings will be analysed by [contractor], 
Aston University and the Healthcare Commission.  The results will be presented in a 
summary report in which no individual's answers can be identified.  
 
We very much hope you agree to take part, and would be grateful if you could return 
your completed questionnaire, to [insert return address].  Blind or visually impaired 
staff may complete the questionnaire over the telephone, by calling the [Advice 
Centre / Contractor name] helpline on [0121 359 2491] / [contractor helpline number]. 
 
If you have any questions or comments about this survey, you can find out more by 
logging onto the Staff Survey Advice Centre web site (www.nhsstaffsurveys.com), or 
by calling [the Survey Helpline on 0121 359 2491 (available 10-4 on weekdays)] [if 
contractor or trust helpline is available, insert detail here]. 



 35

 
Many thanks for your help with this important survey. 
 
Yours sincerely, 
Lorraine Foley 
Head of Information and Analysis 
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Appendix 2 
 

Reminder letter to be sent 3 weeks after original questionnaire 
 
 
Dear Colleague, 

NHS National Staff Survey 
 
About three weeks ago we sent you a questionnaire seeking your opinions about 
working in the NHS.  [Your name was randomly selected from a list of all staff 
working for your NHS trust.] 
 
If you have already completed and returned the questionnaire, please accept our 
sincere thanks, and we apologise for this reminder.  If you have not received a copy 
of the questionnaire, or have any other queries, please contact [Contractor name] on 
[Contractor number]. 
 
If you have not yet completed the questionnaire, please do so today and return it to 
[insert address here].  It is only by hearing the views of as many staff as possible, 
that we can assess the success or otherwise of NHS working practices and policies.  
 
Many thanks for your participation. 
 
 
Yours sincerely, 
 
Lorraine Foley 
Head of Information and Analysis 
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Appendix 3 
 

Reminder letter to be sent three weeks after first reminder 
 

Dear Colleague, 
NHS National Staff Survey 

 
About six weeks ago, we sent you a questionnaire asking about your experiences of 
working in the NHS.  Many staff have already completed and returned this 
questionnaire, and if you have done so, please accept our sincere thanks.   
 
The results of this national survey – the second time such a national survey has 
taken place – will be extremely valuable to the Healthcare Commission, the 
Department of Health and your local trust, for improving patient care and the working 
lives of staff.  This annual survey is an important way of ensuring that NHS staff 
views regularly feed into national and local NHS policies. 
 
If you have not yet returned your questionnaire, we are writing again because of the 
importance that your questionnaire has for helping to get accurate results.  Although 
we sent questionnaires to a wide range of staff in the trust, it is only by hearing from 
everyone in the sample that we can be sure that results are truly representative.  We 
have enclosed another questionnaire in case you have misplaced the original one. 
 
We would like to reassure you that information released to the trust will be in a form 
that protects individuals' anonymity, and any report of the trust survey will be written 
in summary form, in which no individual's answers can be identified.  As the 
questionnaires are sent directly to [contractor] - an independent survey organisation, 
no-one from your trust will see your completed questionnaire, or be able to identify an 
individual's responses. 
 
If you have any queries relating to the survey, please call the [contractor name / 
Advice Centre] helpline on [contractor number / 0121 359 2419].  Blind or visually 
impaired staff may complete the questionnaire over the telephone, by calling the 
same number 
 
 
Many thanks in anticipation of your help. 
 
Yours sincerely, 
 
Lorraine Foley 
Head of Information and Analysis 
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Appendix 4 
 

Summary of files/information to be transferred to the Advice Centre 
 

Document/Information How returned By when By whom Where in 
guidance notes

Name/contact details of two people responsible for 
the survey in the trust 

E-mail As soon as possible Trust Section 2.1 

Number of staff in trust eligible to receive 
questionnaire; size of Basic Sample 

E-mail By October 8th  Trust or contractor Section 2.5 

Name and contact details of person responsible for 
sampling 

E-mail By October 8th Trust or contractor  Section 2.5 

Response rates during the survey period, and dates 
of questionnaire and reminder mailings 

E-mail Weekly after 
questionnaires are 
sent out 

Contractor Section 2.9 

Data documents (Staff sample file, Questionnaire 
data file) 

By post, and as 
attachment to e-mail 

By December 17th  Contractor Section 2.10 

Other information – final response rate & number of 
completed questionnaires received, number of blank 
questionnaires returned, number of questionnaires 
returned with ID number removed, number of 
ineligible staff contacted, number of questionnaires 
checked, number of errors found, password for data 
files 

E-mail By December 17th Contractor Section 2.10 

Questionnaires for data checking By post (recorded 
delivery) 

On request from 
Advice Centre 

Contractor Section 2.10 

Staff list and sample Attachment to e-mail On request from 
Advice Centre 

Trust or contractor Section 2.5 



 39

Appendix 5 
 

Detail of how to perform some procedures in Excel 
 
 
(a) Inserting a blank first row 

Click on the top, left hand cell (usually ‘A1’ or ‘R1C1’) and then “Insert” > 
“Rows”. This should insert a blank row, which can be used for headings. 

 
(b) Deleting rows  

To delete a row, highlight it by clicking on the row number at the extreme left-
hand end of the row, and click on “Edit” > “Delete”. 

 
(c) Deleting columns 

Deleting a column is done in the same way as deleting rows (see b). 
 
(d) Selecting multiple rows 

Place the mouse pointer over the row number of the first row you wish to 
select (on the far left hand side of the worksheet). Click and drag down to the 
row number of the last row you wish to select. When the mouse is released, 
these rows should then be highlighted. 

 
(e) Copying and pasting multiple rows into a new worksheet 

When rows are selected, click on “Edit” > “Copy”. Open a new worksheet by 
clicking “File” > “New”. Paste in the rows by clicking “Edit” > “Paste”. 
 

Changing the cell reference style from ‘R1C1’ to ‘A1’ 
Some operations are easier to carry out with the ‘A1’ style of cell reference, 
rather than the ‘R1C1’. To change this, click on “Tools” > “Options”, then the 
“General” tab, and uncheck “R1C1 reference style”. 
 

Password protecting files 
To make sure that a file can only be accessed by someone who knows a 
password, click on “File” > “Save As”. Then click on “Tools” > “General 
Options”. Enter a password which will protect the file before saving it. 
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Appendix 6 
 

Development of the survey 
 
2003 NHS National Staff Survey: Initial Consultation and Pilot Survey 
Prior to the 2003 survey, researchers consulted widely with more than 400 people 
from a number of trusts, in order to design a questionnaire that is both user friendly 
and will serve to Improve Working Lives.  This questionnaire was tested in a pilot 
study in five trusts in the summer of 2003, before the final version of the 
questionnaire was produced for use in the main 2003 National Staff Survey. 
 
2004 NHS National Staff Survey 
Extensive consultation about the 2003 survey was conducted after it was completed. 
This included: 
• a large scale evaluation of the 2003 survey, based on feedback from more than 

200 trusts, conducted independently by Surrey Social and Market Research, 
University of Surrey (report available for download from the Healthcare 
Commission web site) 

• consultation by the Advice Centre with trust survey leads and HR directors 
• consultation with national bodies and SHRINE chairs 
• extensive analysis of the 2003 survey data 
 
Based on this analysis and consultation, a number of proposed improvements to the 
survey were developed, and some new questions added. 
 
These changes were then tested by cognitive interviews with 45 members of staff in 
five trusts (one acute, one primary care, one mental health, one ambulance, and one 
social care). These interviews were used to establish whether the new and changed 
questions were understood by NHS staff, and whether they were responded to by 
staff in the way which was anticipated. In a few cases where they were not, a few 
final changes to the questionnaire content were made. 
 
A further two questions were added to enable the questionnaire to cover the issues 
required by the Health and Safety Executive’s stress audit.    This means that trusts 
will not need to carry out a separate stress audit to fulfil the HSE's audit 
requirements.   
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Appendix 7 
 

Contact Details of Approved Contractors 
 
 
Maritz 
Contact: Neil Barber / Emma Frodin / Gavin Sugden 
Telephone: 01628 895305 
e-mail: nbarber@maritz.co.uk; efrodin@maritz.co.uk; gsugden@maritz.co.uk 
Maximum survey capacity: 50 trusts 
  
MORI 
Contact: Helen Rice 
Telephone: 020 7347 3000 
e-mail:  helen.rice@mori.com 
Maximum survey capacity: 200+ trusts 
 
NHS Partners’ Research and Information 
Contact: Cheryl Kershaw / Aimi Blueman 
Telephone: 01423 720212 
e-mail: cheryl.kershaw@nhspri.co.uk; aimi.blueman@nhspri.co.uk 
Maximum survey capacity: 300 trusts 
  
Picker Institute Europe 
Contact: Nick Richards 
Telephone: 01865 208100 
e-mail: nick.richards@pickereurope.ac.uk 
Maximum survey capacity: 200+ trusts 
 
Quality Health 
Contact: Reg Race 
Telephone: 01246 856263 
e-mail: qhconsult@aol.com 
Maximum survey capacity: 200+ trusts 
 
RBA Research 
Contact: Karen Bagshaw / Catherine York / Iain Sutherland 
Telephone: 0113 285 6300 
e-mail: karen.bagshaw@rba-research.co.uk; catherine.york@rba-research.co.uk; 
iain.sutherland@rba-research.co.uk 
Maximum survey capacity: 50 Trusts 
  
Taylor Nelson Sofres 
Contact: Pooja Sachdev 
Telephone: 020 8967 4259 
email: pooja.sachdev@tns-global.com 
Maximum survey capacity: 50 trusts 
  
 
More detailed information about the Approved Contractors, including their quotations 
for providing the survey services can be found in the Service Level Agreement which 
is available on the Advice Centre web site (www.nhsstaffsurveys.com). 
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Appendix 8 
 

Sample Honorary Contract 
 
[Name of NHS Trust] 
 
To: [Name of employee] [Date] 
 
1. We are pleased to offer you an honorary (unpaid) appointment with this Trust. The 
appointment is to enable you to carry out the necessary operations and procedures 
that will enable this Trust to participate in the NHS Staff Survey. 
 
2. The period of appointment covered will be from [1st date] to [2nd date]. However, 
your work during this period will be part-time and intermittent, and may well be 
complete before the end of the period. 
 
3. Similarly the pattern of hours worked in any week will vary according to the 
requirements of the survey procedures. The number and distribution of hours will be 
a matter for mutual agreement between you and [name of external contractor]. You 
will of course be covered by the Working Time Regulations 1998 and will not be 
expected to follow other than standard procedures in respect of working time. 
 
4. The work will be carried out off-site at a location to be agreed with [name of 
external contractor]. 
 
5. Since the appointment is unpaid, this contract carries no entitlement to paid 
holidays, bank holidays, sick pay etc. Your entitlements in these respects will be the 
responsibility of [name of external contractor] which is the organisation responsible 
for the overall design, conduct and reporting of the NHS Staff Survey. 
 
6. It will be expected that you carry out your work in a manner which is safe and 
absent from risk to your own health and that of any other person who may be 
affected by your actions or omissions. It is also expected that you will co-operate with 
the Trust in complying with any relevant statutory regulation imposed by the Trust. 
Whilst on Trust premises you must comply with the requirements of the Health & 
Safety at Work Acts 1974 (including Regulations and Codes of Practice issued there 
under). 
 
7. During the course of your work you may have access to information concerning 
the Trust’s staff, policies or finances, which is strictly confidential. It is a condition of 
your appointment that in no circumstances will such information be passed on or 
discussed with any unauthorised person. A breach of confidentiality during this 
contract would result in its termination. 
 
8. It follows from the above that any confidential information and data for which you 
are responsible should be kept under continuous review and stored in secure 
circumstances when it is off-site. The data will be disposed of in a safe manner, and 
any staff details will be destroyed before disposal. 
 
9. If required to work on the Trust premises the Trust cannot accept responsibility for 
articles of personal property lost or damaged on their premises whether by burglary, 
fire, theft or otherwise. You are therefore advised to cover yourself in this respect 
against all risks. 
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10. Notwithstanding the above, for the purpose of employment insurance (and for no 
other purpose) you will be regarded as a Trust employee during the proper 
performance of your duties, provided that at all times you exercise all reasonable 
skills and judgement and always act in good faith. 
 
11. Please sign and return this letter by way of confirmation of your agreement to the 
terms on which the appointment is made. 
 
12. The offer and the acceptance of it should together constitute a contract between 
two parties. 
 
FORM OF ACCEPTANCE 
I hereby accept the terms and conditions set out above. 
 
Signed: ……………………………………………………… 
Date:…………………………….. 
[Name of employee] 
 
Signed: … …………………………………………… Title: …………………………….. 
(On behalf of the Trust) 
[NHS Trust] 
 
13. Date:…………………….. 
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Appendix 9 
 

Ethnic Group codes to be included in staff list 
 
 

Ethnic Origin Code to be included in staff list 

White  
White British A 
White Irish B 
Any Other White C 

Mixed  
White & Black Caribbean D 
White & Black African E 
White & Asian F 
Any other mixed background G 

Asian or Asian British  
Indian H 
Pakistani J 
Bangladeshi K 
Any other Asian background L 

Black or Black British  
Caribbean M 
African N 
Any other Black background P 

Other ethnic groups  
Chinese R 
Any other ethnic Group S 
Not stated Z 
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Appendix 10 
 

Questions for use in the Health and Safety Executive Stress Audit 
 
The core questionnaire has, this year, included additional questions so that the 
Health and Safety Executive’s (HSE) stress audit is covered by the questionnaire. 
Details of the questions which map onto the HSE standards can be found in the 
following table. The HSE has agreed that trusts will not need to carry out a separate 
survey to cover this. The HSE and Healthcare Commission are currently discussing 
how trusts can use this data to report on the survey in such a way that meets HSE 
requirements. This information will be passed to trusts as soon as it is agreed. 
 
 

HSE Stressor Question number 
(core questionnaire) Question text 

 
Control 22g I can decide on my own how to go about 

doing my work 

Role 19a I have clear, planned goals and objectives 
for my job 

Relationships 29c, d In the past 12 months have you 
experienced harassment, bullying or 
abuse from any of the following? 

(c) manager/supervisor 
(d) colleagues 

Relationships 22f Relationships at work are strained 

Demands 19d I cannot meet all the conflicting demands 
on my time at work 

Support 21d I am satisfied with the support I get from 
my work colleagues 

Change 22b I am consulted about the changes that 
affect my work area / team / department 

Support  21b I am satisfied with the support I get from 
my immediate manager  
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Appendix 11 
 

Changes to questions in the Core Questionnaire 
 
 
Core questionnaire number  Change made 
2004 survey 2003 survey   

1b, c 1b  Average number of extra hours worked in a week 
split into paid hours (1b) and unpaid hours (1c) 

7a, b 7a  “Do you work shifts?” changed to: 
• “Do you work rotating shifts?” 
• “Do your working hours include any time 

between 7pm and 7am?” 
Response option “Yes” split into “Yes, regularly” 
and “Yes, occasionally” 

23 23  “…manager / supervisor” extended to “…manager / 
supervisor / team leader” 

36 35  “Do you have a disability” changed to “Do you have 
any long-term illness, health problem or disability 
which substantially limits your daily activities or the 
work you can do?” 

39 36  Occupational groups added: 
• “Social Workers / Residential Social Workers” 
• “Social Care Managers” 
• “Social Care Support Staff” 
“Ambulance Person” replaced by 
• “Ambulance Driver / Support Staff” 
• “Ambulance Control Staff” 

2h, 16a, 24, 
25, 28, 29 

2g, 16a, 24, 
25, 27, 28 

 References to “Patients” replaced by references to 
“Patients / Service users” 

 
In addition, some new questions have been added to the questionnaire. These are 
questions 2c, 12a, 16c, 19f, 19g, 20e, 22f, 22g, 26b, 27 and 38 in the 2004 Core 
questionnaire. 


